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CHAPTER 4:  INVENTORY LIST 
 

The Inventory List contains all of your items that you sell to your clients or use in treating your 
patients. In setting up your Inventory List you will need to create Inventory Categories, assign prices, 
set up your Vendor list, and so on. The AVImark Inventory List identifies Inventory Categories, items 
within each category and a Selected Items section. 
 
In this chapter you will learn how to: 
 
“Set up Your Inventory Categories” on page 1 
“Use the Inventory Categories Shortcut Menu” on page 3 
“Add an Inventory Item” on page 4 
“Use the Inventory List Shortcut Menu” on page 15 
“View and Print Inventory Reports and Documents” on page 25 
“Update Inventory Sales” on page 26 
“Add Vendors” on page 26 
“Create Purchase Orders” on page 26 
“Purge Orders” on page 29 
“Setup Associated Veterinary Purchasing for Canadian Clinics” on page 29 
“Work with VPR Formulary” on page 29 
 

Set up Your Inventory Categories  
• To work with your Inventory List, open the Work with menu and click Inventory.                
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Add or change an Inventory Category 

• Point in the Inventory Categories list area.  Right-click and from the shortcut menu click New 
to display the New Inventory Category window. 

 
• Enter the appropriate information into each field and click Done to add or change the 

category. 
 
Category 
This is the descriptive name give to each category to identify it in most AVImark functions.   

• Type the name you wish to give the new category. 

 
Report Codes 
Report codes are user-defined letter characters used for grouping specific items together on certain 
reports (Treatment Control Log, Patients by Treatment, Income by Treatment, Transaction Summary, 
and Sales Summary).  You can have up to 7 codes for each category.  Some codes are pre-
programmed.  They are: 

o Injections (I) 
o Lab Services (L) 
o Prescriptions (P) 
o Surgery (S) 
o Vaccinations (V) 

• If appropriate, use the drop-down list and select the correct Report code(s) for the new 
category. 

 
Markup Percentage  
The Markup percentage is the default percentage used to mark up the prices of items in this category. 

  
If you would like your categories to be in numerical order, change each category name by 
typing a number in front of a category name.  For example: 01Pharmacy, 02Supplies. 
 

  
AVImark already has controlled substance tracking and is dependant upon the “C” action 
code on the appropriate item. 
 



  Chapter 4:  Inventory List 

 3

• If appropriate, use the UP and DOWN ARROWS to specify the Markup Percentage for this 
category.  You can always type a different Markup percentage at the time you initiate the 
actual mark up process. 

 
Account number  
To interface with QuickBooks, you will need to enter the income account number that you set up in 
QuickBooks as the account in which to record the income generated from inventory within this 
category.  If specified, this account number is used as the account name for QuickBooks instead of the 
Inventory Category name. 

• If appropriate, use the UP and DOWN ARROWS to specify the income account number that 
you have set up in QuickBooks. 

 
Report name 
The Category Report name must be given for use in the End-of-Period reports.  This name can be 
different or the same as what was typed in the Name field. 

• Type a Category Report name. 

To learn more about: Search the Help for:  
 

Printing Reports 
Using Report Codes 
QuickBooks® Interface 
 

Inventory Reports 
Inventory Report Codes 
QuickBooks® 
 

 
Whiteboard 
This field represents the Whiteboard categories that are set up in “System Tables”.  They are used to 
group and organize items on the ‘Whiteboard’.  

• Use the Whiteboard drop-down list and select the Whiteboard category you wish to assign to 
this category. 

 
Company 
Having the ability to assign company numbers to individual codes as well as entire categories allows 
detailed reporting by company to be much more accurate.  This same number can be assigned to 
multiple items.  

• If appropriate enter the desired company number for reporting purposes.  
 
Category and Item colors 
AVImark will highlight the category and item names in red, blue, or gray depending on the following 
criteria: 

• If the On-hand Quantity of an item is equal to or less than its Order Point, the category name 
and item itself will be displayed in red. 

• Items that are currently on an open order will be displayed in blue. 
• Obsolete items (items that you want to keep on the list, but not for selection) are displayed in 

gray. 
 

Use the Inventory Categories Shortcut Menu 

In the Inventory Categories list window, there are several things that you can do from the shortcut 
menu.  Use the right-click option in the Inventory Categories list to see the shortcut menu. 
 
Remove an Inventory Category 

• Select the Inventory Category you wish to remove.  Right-click and from the shortcut menu 
click Remove. 
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• You will need to click Yes to confirm. 

 
Move to Treatments 
Use this feature to move an Inventory Category and all its items to the Treatment List.  However, all of 
the notes, drug label messages, doctor’s instructions, and other values specifically for inventory, will 
NOT be moved. 

• Select the Inventory Category you wish to move.  Right-click and from the shortcut menu 
click Move to Treatments. 

• You will need to click OK to confirm. 
 
Undelete a deleted Inventory Category or individual item 
AVImark gives you the ability to undelete Inventory Categories or individual items from within the 
category.   

• Point in the Inventory Categories window.  Right-click and from the shortcut menu click 
Undelete Categories to display the Undelete Item Categories window. 

• Use the SPACEBAR or right-click and from the shortcut menu click Select to choose the 
categories and/or individual items you wish to undelete.  Items that are selected will be 
bolded. 

 
Add an Inventory Item 

The right half of the Inventory List Window displays the Item List for the category currently selected.  
Working in this window, you are able to add new items and/or specify information about each of the 
existing items you use. 

• Select the correct Inventory Category to add the items to. 
• Point in the Items List for section. Right-click and from the shortcut menu click New to    

 display the New Item window. 

 
 

 

 

 

 

 

 

 

 

 

  
Removing an Inventory category also removes all items within that category. 
 

  
It is highly recommended that you make a backup of your AVImark® data before 
proceeding.  Once the move procedure is completed, there is no undo option. 
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General Tab Values 
Find 
Use the Find menu button to quickly locate a field. 

• Click the Find button. 
• From the drop-down list select the field you are searching for and click OK. AVImark will 

then place the cursor in the selected field.  
 
Code 
You may use up to 8 characters, either numbers, letters, (or a combination of both) for an item.  
AVImark will not allow you to use the same Inventory Code for a treatment, diagnoses or another item 
that has already been entered. 

• Type a code for the item. 
 
Description 
This is the description that will appear on all Period reports and in the Medical History of those 
patients receiving the item. 

• Type the description you wish to assign the item. 
 
On Hand quantity 
This is the number of items as dispensed that you have on hand.  For example, you are trying to specify 
the on hand quantity for some capsules for which the minimum you can order from the vendor is a 
bottle of 100.  You have 3 bottles of 100 capsules plus 52 more in an open bottle.  You would set the 
On Hand quantity to 352. 

• Use the drop-down list to display the calculator and to enter the current on hand quantity. 
 
Location 
This field identifies the location code or where the item is located in your facility. 

• If appropriate, type a location code for the item.  For example, CAB1. 
 
Action codes  
Action codes cause AVImark to perform certain functions. 

•  If applicable, use the drop-down list and select the appropriate Action codes. 

The following table lists each Action code and its meaning: 

Code Meaning Description 

A Automatic drug label Prompts the drug label window to display when the item is entered into 
medical history. 

C Controlled Substance Marks this item as a controlled drug and includes it on the controlled 
substance report. 

D Treatment causes 
death 

Automatically marks the patient as deceased when the item is entered into 
medical history. 

E Print one 
document/patient 

Prompts a document for each patient that has received the same item in 
medical history for a client. 

F Include on travel 
sheet 

Includes this item on the AVImark travel sheet. 

H Handling fee Includes the handling fee with the price of the Item. 

I Integer pricing Rounds the price of an item that has a partial quantity to the price of the 
nearest whole number. 

K Prompt to include in 
group 

When included within a treatment group this action code will prompt you if 
you would like to enter the Item in medical history. 
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L Subject to local sales 
tax 

Includes the local/PST tax to the price of this Item as defined in hospital 
setup. 

M Intramuscular 
injection fee 

Includes the intramuscular fee to the price of this Item as defined in 
hospital setup. 

N Don’t print on 
patient chart Suppresses the printing this Item on the patient’s printed chart. 

P Prescription fee Includes the prescription fee to the price of this Item as defined in hospital 
setup. 

Q Don’t post to invoice Will not include this Item on the printed invoice.  This Item will be entered 
in medical history and displayed as already posted. 

R Rabies vaccination Indicates this Item as a rabies vaccination.  This action code will also 
prompt for the vaccine information window. 

S Subject to state sales 
tax 

Includes the state/GST tax to the price of this item as defined in hospital 
setup. 

T Subject to state and 
local sales tax 

Includes both state & local/PST & GST tax to the price of this item as 
defined in hospital setup. 

V Intravenous injection 
fee 

Includes the intravenous fee to the price of this item as defined in hospital 
setup. 

W Auto prompt for vital 
signs 

Automatically prompts for the Medical Condition Record (SOAP) to 
display when this item is entered into medical history. 

X Causes sex alteration Automatically updates the patient’s sex to spayed, neutered or gelded 
depending on the previous sex and species of the patient. 

Y Assign certificate 
number 

Automatically assigns a certificate number when this item is entered into 
the patient’s medical history. 

Z Dietary item Includes this item on the dietary tab at the bottom of the CID screen. 

$ Include price on 
chart 

This action code will include the price of the item on the printed patient 
chart. 

- Obsolete treatment Marks a item as obsolete and grays it out on the list.   

@ Auto prompt for 
document 

Prompts to print the linked document.  Without this action code AVImark 
will automatically print the liked document with the invoice. 

 
# 

 
Don’t print 
form/document 

 
Suppresses the printing of the linked form or document. 

* Auto prompt for 
notes 

When entered into medical history it will automatically prompt for a notes 
window to enter information about the item. 

? Schedule follow-up 
at posting 

This action code will display the follow-up window when posting instead 
of when the item is entered into medical history. 

! Show warning if 
quantity is equal to 1 

This action code will display a warning if the item entered in medical 
history has a quantity equal to one. 

^ Not for retail Does not allow the staff members to sell this item. 
( Control refills Allows you to control refills on this item if a drug label is being printed. 

> Don’t print notes on 
chart 

Will not include the entered medical history notes on the printed patient 
chart. 

= Don’t use additional 
fees 

Does not allow the additional fees (intra-muscular, intravenous, 
prescription, etc) to be added to the price of the item. 

% Auto copy notes into 
medical history 

Copies entered notes on the treatment automatically into a notes window in 
medical history. 

~ Auto hide notes in 
medical history Will not display the entered medical history notes on the CID screen. 

[ Auto prompt for the 
microchip number 

Automatically prompts for the patient’s microchip number and will enter 
the number into the patient’s area of the CID screen. 
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{ Prompt for the 
locator number This action code will prompt for a number to be used with ePetRecords®. 

} Don’t add to 
Whiteboard 

Will not include this item on the whiteboard automatically when entered 
into medical history. 

1 Don’t post from 
Whiteboard 

When posting items from the whiteboard this action code will not post the 
item to medical history. 

< Include on the E-
Travel sheet Includes this item on the electronic travel sheet. 

2 Show Notes in 
Medical History 

This action codes allows you to view specific notes with the option selected 
of “Show all with note action” in medical history. 

5 Dental Assessment Automatically prompts the dental chart to display when the item is entered 
into medical history. 

 
Price 
The field represents the amount you wish to charge a client for the item.  AVImark also gives you the 
ability to use Integer pricing based on the use of the “I” Action code.  When you sell or dispense a 
decimal quantity of the item (1.5 cc), AVImark will price the item as though you entered the next 
higher whole number.  That is, what you would charge for the quantity of 2 cc. 

• Use the UP and DOWN ARROWS to specify the normal amount you wish to charge the 
client for the item. 

 
Unit Cost  
In this field you will specify the cost for the item.  For example, say you have some dog food that is 
ordered by the case of 24.  The cost for the package (24) is $18.25.  The Unit Cost field should display 
$0.76 which is the Package Cost divided by 24. 

• Use the UP and DOWN ARROWS to specify the Unit Cost. 
 
Package Cost  
In this field you will specify the package cost for the item.  For example, say you have some dog food 
that is ordered by the case of 24.  The cost for the case of 24 is $18.25.  Therefore, the Package Cost 
entered for this item will be $18.25.   

• Use the UP and DOWN ARROWS to specify the Package Cost for the item. 
 
Class (Discount) 
AVImark uses the Class field to determine which items are to be discounted to which client class.  You 
may set up an unlimited number of client classes as well as treatment and inventory classes.  For more 
information on discount classes, refer to “ 

• If applicable, use the Class drop-down list and select the appropriate discount class. 

To learn more about: Search the Help for:  
 Setting up client discounts Inventory discounts; Class discounts 

 
Report Codes 
Report codes are user-defined letter characters used for grouping specific items together on certain 
reports (Treatment Control Log, Patients by Treatment, Income by Treatment, Transaction Summary, 
and Sales Summary). You may use up to 3 codes for each item.  There are some codes that are pre-
programmed for use with the most common reports.  They are:  

 
o Lab services (L) 
o Surgery (S) 
o Injections (I) 
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o Prescriptions (P) 
o Vaccinations (V) 

• If appropriate, use the drop-down list and select the correct report code(s) for the item. 
 

 
Measure 
This field is used to specify how the item is dispensed.  This list is set up in the Units of Measure Table 
in the AVImark System Tables.  For more information on setting up your Unit of Measure Table, refer 
to “Chapter 2: SYSTEM TABLES”. 

• Type an abbreviated unit of measure or use the drop-down list and select how the item is 
dispensed. 

 
Fee 
In addition to the add-on fees applied through the use of certain Action codes, AVImark also gives you 
the ability to define a customized list of fees that will be added to the price of the item. These fees are 
set up in the Special Fees Table in the AVImark System Tables. For more information on setting up 
the Special Fees Table, refer to “Chapter 2: SYSTEM TABLES”. 

• If appropriate, use the drop-down list and select the special fee code for this item. 
 
Photo 
AVImark lets you link any .bmp; .jpeg; or .tif image to the item to be printed on the client invoice 
attached to the doctor’s instructions for the item. When this item is included on the client invoice, this 
photo will be printed at the bottom half of the invoice along with take-home instructions.  However, if 
there are no take-home instructions linked with the item, the photo will not be printed. 

• If appropriate, use the Photo field browse button  to open the folder of your saved photo 
files. 

To learn more about: Search the Help for:  
 Using photos in AVImark  Photos; Inventory Photos 

 
Category 
This field allows you to move inventory from one category to another. 

• If appropriate, use the drop-down list and select the correct category. 
 
Expires/Expires after__days 
This field displays the expiration date of the current purchased “lot”.  Both expiration fields can be 
used at the same time.  If the manufacture expiration date is set for the item along with the number of 
days past dispensing of the drug, AVImark will print the date that is closest to the dispensing date.   

• Using the Expires field drop-down calendar, enter the expiration date of the current 
purchased “lot” and/or specify the number of days this product will expire when the item is 
being dispensed. 

 
UPC Code 
This field allows you to enter a UPC number for the specific item.  This can be done either by typing 
the code or swiping the UPC code label to input the number. 

• If appropriate, enter the UPC number for the item. 

  
If you need to assign a separate inventory-specific report code to both the individual items 
and Inventory categories AVImark will honor both report codes. 
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MSDS (NDC, DIN) 
This field identifies the location of the MSDS sheet for the item. If you have a “DEA” number entered 
in Hospital Setup on the Demographics tab, this field will automatically change to “NDC” number and 
is used primarily for Kentucky, Michigan, California, New York and Alabama hospitals. Refer to the 
item documentation to determine the correct NDC identification for each controlled substance.  For 
Canadian users, the label "DIN" will show instead of the MSDS. For the KASPER, CURES and ASAP 
reporting function to work, each controlled substance will also need to have a “C” Action Code 
assigned.  
 
Break QTY/Price 
This is the number and price of the item above which (or up to the second Quantity Break) you would 
charge the client.  AVImark gives you two levels for setting up quantity break prices.  When you set 
the price in this field, you are entering the price charged for the Quantity Break number, NOT the price 
for each individual item.  Just to the right of the Quantity Price amount, AVImark will display the 
markup this price represents over the Markup Cost of the item. 

• In the first column simply type the quantity or use the Up and Down Arrows to specify the 
quantity. 

• In the second column type the break price or use the Up and Down Arrows to specify the 
price for the quantity break price (not for each item). 

 
 
Mark up Break Price(s) 
This option allows you to have AVImark mark up the quantity break prices whenever you mark up 
retail prices. 

• If appropriate, select Mark up Break Prices. 

To learn more about: Search the Help for:  
 

Setting up break pricing 
Marking up break prices 
 

Break pricing 
Markup break prices 
 

 
Mark up Percent 
With inventory items, you can specify a mark up percentage for both the Inventory category and the 
item itself.  When a mark up is done, AVImark will honor any item-specific percentages rather than 
the percentage set for the category. 

• If appropriate, use the UP and DOWN ARROWS and specify the mark up percentage for the 
item using a whole number. 
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Mark up Unit Cost  
If you use the purchase order function, AVImark will automatically maintain this amount as the 
highest cost you have ever paid for the item. This field will represent the cost that you want future 
mark ups to apply to.  Furthermore, it is used as the basis for inventory surcharges added to treatments.   

• If appropriate, use the UP and DOWN ARROWS to specify the cost that is the same as or 
higher than the current Unit Cost. 

 
Mark up Pkg Cost  
If you use the purchase order function, AVImark will automatically maintain this amount as the 
highest cost you have ever paid for the item package.  This field will represent the cost that you want 
future mark ups to apply to.  Furthermore, it is used as the basis for inventory surcharges added to 
treatments.   

• If appropriate, use the UP and DOWN ARROWS to specify the cost that is the same as or 
higher than the current Package Cost. 

 
Species 1 & Species 2 
You may specify up to 2 different species for the item.  If you attempt to enter the item into the 
Medical History of a patient whose species is other than what is selected here, the item will NOT be 
entered and you will receive a warning message. 

• If appropriate, use the drop-down list and select the appropriate species limitation for the 
item. 

 
Doctor 
AVImark allows you to specify a default doctor that will automatically be selected when you enter the 
item into the Medical History area of the patient. 

• If appropriate, use the drop-down list and select the default doctor for the item. 
 
Sex(es) 
You may restrict certain items to patients of a certain sex. 

• If appropriate, use the Sex(es) field drop-down list to select the appropriate Sex code(s). 
 

Advanced Tab Values 
Follow up 
The Follow-up area allows you to specify values that will determine how patients receiving the 
selected items will be handled by the AVImark Follow-up function.  For a detailed discussion on the 
AVImark Follow-up feature, refer to “Chapter 27: FOLLOW-UP LIST”. 
 
Follow-up in…days 

• If appropriate, use the UP and DOWN ARROWS to specify the number of days, after which 
receiving the item, you want the patient to be due for a Follow-up. 

 
Follow-up Critical 
This option allows you to identify the follow-up to be of critical importance. 

• If appropriate, select Follow-up Critical. 
 
Subject 
The Subject field defaults to the Item description.  You may assign a different subject or reason if you 
wish. 

• If appropriate, assign a different subject or reason. 
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Remind as 
In AVImark, reminding for inventory items and treatments is primarily controlled by Reminder 
Templates.  “Remind as” allows you to use the reminder setup of another item. Code and description 
drop-down lists are available for display and selection of all Treatment, Inventory, and Diagnosis 
codes containing reminder templates. 

• If appropriate, use the drop-down list to select either the code or description of the treatment, 
item, or diagnosis that you wish the patient to be reminded for when this item is dispensed.  In 
this way, you do not need to set up a Reminder Template for this item. 

 
Company 
Having the ability to assign company numbers to individual codes as well as entire categories allows 
detailed reporting by company to be much more accurate.  This same number can be assigned to 
multiple items.  

• If appropriate enter the desired company number for reporting purposes.  
 

Contract Prices Tab Values 
If adding a new item you must first save the item before setting up the contract prices information for 
the item. This tab allows contract prices to be defined for Inventory.  Before contract prices can be 
defined, descriptions for the prices must be created.  These descriptions can be created from either the 
Contract Prices Tab or from the Contract Pricing Table within System Tables.  For detailed 
information on adding new Contract Pricing entries to System Tables, refer to “CHAPTER 2: SYSTEM 
TABLES”.   

• To create a new description from the Contract Prices window, right-click and from the 
shortcut menu click New to display the New Item Contract Price window. 

 

• In the Description field, click the New button  to display the New Contract Price Code 
Entry window. 

 
• Type a single character code in the Code Field. 
• Type the description for the new entry in the Description field and click OK. 
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Documents Tab Values 
If adding a new item you must first save the item before attaching documents to the item. AVImark 
allows you to associate a Microsoft Word document or Star Office document with an Inventory item. 
You can print this document at the time it is first entered into the Medical History of the patient or at 
the time the invoice is printed, depending on what Action Code you enter for the item.   

• To enter the document name, right-click and from the shortcut menu click New to display the     
 New Item Species Entry window. 
• Use the Species drop-down list and select the appropriate species. 

• Use the Document field browse button  to open the folder of your MS Word Documents. 
• Select the appropriate document and click OK. 

 

Pharmacy Tab Values 
Refill time/treatment link 
If you wish to track the number of refills that is allowed, you will need to specify the length of time (in 
months) that refills are allowed. You may also specify a Treatment Code in the next field to indicate 
that, if this treatment is performed on the patient, it is as though the refill count should be restarted at 
the beginning.   

• To control refills, use the UP and DOWN ARROWS to indicate the number of months during 
which refills are allowed. 

• To track refills starting with a certain Treatment code, enter the code in the next field. 
• To select the Minimum interval between refills…days, use the UP and DOWN ARROWS 

to specify the minimum number of days between refills. 
 
Container__with__ 
Certain inventory items may be designated as controlled substances based on the “C” Action Code, 
which may then be tracked and reported by AVImark.  Recent requirements by AAHA specify that 
controlled substances must be tracked by what is called a Container Identification Number.  These two 
fields are used for tracking controlled substances that have Container ID numbers. 

• Use the Container field UP and DOWN ARROWS to specify the Container ID number. 
• In the With field, use the UP and DOWN ARROWS to enter the quantity of this item that 

remains in the current container. 
 
Strength (California) 
The state of California requires that CA drug labels show the drug strength and the number of refills on 
each label.  This field will automatically appear if the state of California is entered within the 
demographics tab of hospital setup.  To properly label each prescription AVImark meets this 
requirement by including strength of the drug and the number of refills on all dispensed prescription 
medication.  For clinics not in California that wish to use this field you must set the Hospital Advanced 
Option, Display Drug Strength to True.  
 

Purchasing Tab Values 
If adding a new item you must first save the item before setting up the purchasing information for the 
item. Each item has its own purchasing and sales information. Some of this information, such as “On 

  
By default, the document will print when the invoice is printed for the client.  If you specify 
the “at” symbol (@) action code for this item, AVImark will print the document at the time 
the item is entered into the Medical History area of the patient instead of when the invoice 
is printed. 
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Order” and “Monthly Sales”, is maintained by AVImark. Other values must be defined for the 
purchase ordering features of AVImark to work. 

 
 
On Order 
This is the quantity of this item that is currently in an Open Order. AVImark sets this number for you 
when you create a Purchase Order. 
 
Order Qty 
This is the quantity of this item (as dispensed in your units of measure) that you want to order at one 
time. The Order Quantity must always be either equal to or a multiple of the Order Pack. When you 
create the order AVImark will order a sufficient quantity, in multiples of the Order Quantity, in order 
to bring the On Hand quantity ABOVE the Order Point. 

• Use the UP and DOWN ARROWS to specify the appropriate Order Quantity, equal to or a 
multiple of the Order Pack. 

 
Order Point 
This is the quantity that you want to maintain on hand. 

• Use the UP and DOWN ARROWS to specify the minimum quantity that you want to keep on 
hand. 

 
Order Pack 
The Order Pack is the quantity of the item that is shipped in the manufacturer’s package.  It is also 
called the “Case lot” quantity.  For example, MEDS1 are shipped from the manufacturer in bottles of 
100 tablets. Even though you dispense the item one tablet at a time, the Order Pack would be 100. 

• Use the UP and DOWN ARROWS to specify the quantity of this item as dispensed per 
manufacturer’s package. 

 
Allocated Qty 
In this field, AVImark tracks the quantities of an item entered into the Medical History of a patient, but 
not posted to accounting.  With this feature, when the item needs to be ordered, AVImark will consider 
its Allocated Quantity to determine the quantity needed in order to bring the On Hand quantity above 
the Order Point. 
 
Mfg Code 
This field displays the manufacturer’s item number. 
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• Type the manufacturer’s item number. 
 
Average Unit Cost 
When setting up a new item, you can leave this field blank and AVImark will automatically set it to 
what was specified for the current “Unit Cost” field.  AVImark maintains the item cost as the average 
price paid from any vendor and will include shipping, taxes, and any other costs incurred when the 
item was ordered.  AVImark uses this cost to calculate stock levels on the Inventory Report. 
 
Average Pkg Cost 
When setting up a new item, you can leave this field blank and AVImark will automatically set it to 
what was specified for the current “Package Cost” field.  AVImark maintains the item cost as the 
average price paid from any vendor and will include shipping, taxes and any other costs incurred when 
the item was ordered.  AVImark uses this cost to calculate stock levels on the Inventory Report. 
 
Last P/O 
This field represents the Purchase Order number of the last order that was created. 
 
Vendor 
This field allows you to enter and display the vendor information from where the item is purchased.  
When a vendor is selected for an item, that vendor’s name, address, phone number, fax number, 
contact’s name, email address, and website will now be displayed beneath the vendor drop-down list. 

• Use the Vendor drop-down list to select the correct Vendor for the item. 
 
Purchase history 
This field displays the Purchase Order history for the item. This area allows entries corresponding with 
Purchase Orders, to be viewed in a READ ONLY view.   

• To view the history of an entry, select the appropriate entry. 
• Right-click and from the shortcut menu click Order Details. 

 
Sales Tab Values 

For each inventory item, AVImark tracks sales information including units sold by month and year-to-
date sales. 

 
 
MTD Sold/Sales 
This value is maintained by AVImark as the month-to-date units sold and total sales. 
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YTD Sold/Sales 
This value is maintained by AVImark as the year-to-date units sold and total sales. 
 
Sales, Last 12 months 
You may view the demand statistics for each month of the year. 

 
Whiteboard Tab Values 

The Whiteboard tab of the Change Item window allows you to specify the applicable values that will 
be used in grouping patients and inventory together on the Whiteboard.  For detailed information on 
the AVImark Whiteboard feature, refer to “CHAPTER 19: WHITEBOARD”. 
 
Whiteboard 
This field allows you to select the Whiteboard category you wish to assign to this specific item. These 
categories are set up in the Whiteboard Categories Table within System Tables. 

• Use the drop-down list and select the appropriate Whiteboard category. 
 
Frequency 
This field holds the default value for the frequency (number of times this service is to be administered 
daily) when this code is added to Whiteboard. 

• Use the UP and DOWN ARROWS to enter the default value for the Frequency. 
 
Use the Inventory List Shortcut Menu 

Within the Inventory List window there are other features found in the shortcut menu.  Use the right-
click option to see the shortcut menu. 
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Add a duplicate item 
AVImark allows you to add a new item to your list that is a duplicate of one that you have already 
entered.  This will be useful if you are adding several items that have the same characteristics. 

• From your Item List, select the item you wish to duplicate. 
• Right-click and from the shortcut menu click Another to display a duplicate New Item 

window.    
• Enter a new Inventory Code for the duplicate item as well as any other necessary changes 

and click Done. 
 
Select 
Select items to be added to medical history, a Need List or a Purchase Order. 

• With the correct item selected, right-click and from the shortcut menu click Select or press the 
Spacebar. 

• Items will be added to the Selected area.  
 
Edit Changes 
Use the Edit menu to select items or to undo or redo changes to an item. 
 
View 
From the View shortcut menu you can Refresh the window, customize columns, view the Entry 
History for this item, Preview or Hide text associated with the item or you can choose how to sort the 
window. If you have customized the display by arranging and adding or removing columns you can 
print the display by using the Print option from the View menu.   
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Entry History 
Use this option to view a history of changes made to the selected item. 

• Select an item and choose right-click View, Entry History. 
• View date and time change was made, logged in user who made the change and a description 

of the change that was made. 
• Click Done to close the window. 

 
Move items into another category 
You can easily move items from one category to another. 

• With the correct item(s) selected, right-click and from the shortcut menu click Move. 
• You will need to click Yes to confirm the move.   
• Click the appropriate category name to move the item to. 

 
Add items to the Need List 
The Need List is like a shopping list of items that need to be ordered. You may create one or more 
Need Lists.  The Need List can also be created either before or after items are selected. 

Before items are selected: 
• From your Inventory List window, open the Need List menu. Click New to display the Create 

Need List window. 
• Type a Name for this Need List and click Continue to display the new Need List. 
• Click Done to close the new Need List. 
• Select the items you wish to add to the new Need List.  Use the SPACEBAR or F10 to place 

the items in the Selected Items area. 
• Open the Need List menu and click Choose to display the Choose Need List window. 
• Select the correct Need list and click Continue. 
• You will need to click Yes to confirm adding the items and display the Need List.  
• Click Done. 

 
After items are selected: 

• Select the items you wish to add to the new Need List.  Use the SPACEBAR or F10 to place 
the items in the Selected Items area. 

• Open the Need List menu and click New to display the Create Need List window. 
• Type a Name for this Need List and click Continue to display the new Need List.  The items 

previously selected will be added to the new list. 
 
Drug label 
AVImark allows you to print prescription labels for any item in the list. 

• From the right-click shortcut menu, click Drug Label to display the AVImark Drug Label 
window. 

• Enter the appropriate information you wish to appear on the label and click Print. 
 
Display and print graphs 
For any given item, you may display one or more graphs showing production, profit, trends, etc.  You 
may display and print graphs using either AVImark’s Graphing feature or Excel.  This option is 
selected in the Advanced area of Hospital Setup. 

• From the right-click shortcut menu, point to Graph and click the graph you wish to display. 
 
Instructions  
You may attach take-home instructions to any item to be printed automatically on the client invoice.  If 
you have several items in your list that have similar Doctor’s Instructions, AVImark gives you the 
ability to include tag-a-long (duplicate) instructions without having to type them again for every 
similar item.  In addition, you may select Doctor’s Instructions that you have saved in your Note 
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Glossary.  For detailed information on tag-a-long instructions and the AVImark Note Glossary, refer to 
“CHAPTER 30: NOTE GLOSSARY”. With the correct item selected, right-click and from the shortcut 
menu click Instructions to display the Doctor’s Instructions window. 

• Type the take-home Doctor’s instructions.  All the available AVImark note feature options are 
available from this window. 

• To include a tag-a-long instruction, type the Item Code of the “parent” item enclosed in 
asterisks.  For example, (*220*). 

 

• Click Done to save the Doctor’s Instructions. 
• These instructions can be viewed or modified from the Medical History area. Once the item 

has been entered select right-click Instructions. 
 
Mark up 
AVImark allows you to mark up three specific inventory values; current prices, mark up percentages, 
and mark up costs for individual items.  You may mark up your item prices in three ways; by category, 
all items, or by individual item.  The Mark up Percentage is set up on each item.   
This is the default percentage that AVImark will use to mark up the item prices (unless otherwise 
directed). You may also specify a Mark up Percentage on individual items.  Item-specific Mark up 
Percentages will override the Mark up Percentage of the category during the mark up process.  

• To mark up items in one category, select the category you wish to mark up prices for. 
• Point to the Item List window and right-click to display the shortcut menu. 
• Click Mark Up to display the Inventory Mark up window.     

  

  
Tag-a-long Instructions must be instructions from another inventory item, not a diagnosis 
or treatments. 
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• By default, the Inventory Mark up window will increase Current Price of items in This 

Category. 
• The default Calculation will Multiply the Mark up Cost by the Mark up Percentage. 

 
Rounding prices 
You may round off marked up prices larger than a certain amount to the nearest increment.  
Furthermore, you may then subtract a specified amount from the result of the mark up to arrive at the 
final price.   
For example:  Lets say you would like to mark up all prices in the selected category by 5% and at the 
same time round off all prices over $10.00 to the nearest 10 cents, all prices over $25.00 to the nearest 
$1.00 minus 5 cents, and finally all prices over $100.00 to the nearest $10.00, minus 5 cents.   

o In this example, the first thing you would do is enter 5 in the By % field. 
o In the Rounding Prices dialogue box, click on the top line in the “If greater than” 

column.  Specify 10.00 in this field and 0.10 in the “Round to” column. 
o Next, on the middle row, specify 25.00 in the left column, 1.00 in the center column 

and 0.05 in the right column. 
o Finally, on the third row, specify 100.00 in the left column, 10.00 in the center 

column and 0.05 in the right column. 

• To review the proposed mark up results before finalizing the mark up process, ensure the 
Review before mark up box is checked and click Continue. 

• By utilizing the Hospital Advanced Options for rounding you can have AVImark default to 
the specified rounding information.  
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The Mark up Analysis window 
In the Mark up Analysis window you can review the proposed mark up results before actually marking 
up your prices.  Once you click Continue from this window, AVImark will mark up prices as directed. 

 
Additional columns can be displayed in the Markup Analysis window by setting the appropriate 
default Hospital Setup Advanced Option. 

• From the CID select the Hammer, Screwdriver and Wrench speed bar icon. 
• In the search field type sales and select the option Show Sales Data By Default and set the 

value to True.  
The Markup Analysis window will now display the Fiscal Income Fiscal Sold, Projected Income, 
Income Difference and Income Difference Percent. The sales data amounts will be figured at the 
bottom of the analysis window.  

• In the Markup Analysis window select View, Show Sales Data from the menu area to hide or 
display the 5 additional income columns.  

In the Markup Analysis window you can customize the view by arranging columns and using the 
Show/Hide Group Panel options from the View menu.  
 
Save and Print Markup Values 
In the Analysis window you will have the ability to save the markup values to a .dat file and also open 
previously saved files.  

• In the Markup Analysis window select File, Open from the menu to open a previously saved 
.dat file that contains markup pricing information. 

• To save markup values currently displayed in the Analysis window select File, Save As from 
the menu area. Enter a file name, location and click Save.  

• To print the markup analysis values select File, Print from the menu.  
 

To learn more about: Search the Help for:  
 Marking up prices Markup 
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Mixture items 
This option allows you to link items to the parent code.  The number of items that can be linked is 
unlimited.  When the parent code is added to a patient’s Medical History, the linked items will be 
deducted from their individual on-hand quantities, but they will not be directly added into Medical 
History.  The linked items can be viewed by clicking on the Inventory Used attachment to the right of 
the Medical History area.  The linked items’ quantity will be a multiple of the parent code’s quantity.  
The linked items do not have the ability to Surcharge by the linked items cost or price.   

• In the Mixture for window, right-click and from the shortcut menu click New to display the 
New Item Usage window. 

 
• Type the appropriate Code or Description for the item. Typing a few characters of the 

description will display a menu from which you can select the correct item. 
• Use the Quantity field UP and DOWN ARROWS to specify the mixture and click OK. 

To learn more about: Search the Help for:  
 Creating mixtures Mixture; Mixture items 

 
Notes 
You may use this feature to add notes about the item.  These notes do not appear anywhere else and are 
not printed on the invoice.  However, all of the other AVImark note feature options are available 
within the note window.  For detailed information on adding notes, refer to “CHAPTER 30: NOTE 
GLOSSARY”. 
 
P/O History 
With this feature you are able to view, change and print the purchase history for any item.  You can 
also return items to a vendor from this purchase history window. 

• With the correct item selected, right-click and from the shortcut menu click P/O History to 
display the Purchase Order History window. 

• To change information about an item, select the correct item. 
• Right-click and from the shortcut menu click Change to display the Change P/O History 

window.   
• Make any necessary changes and click Done. 
• To return an item to the vendor, select the correct item from the Purchase Order History 

window. 
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• Right-click and from the shortcut menu click Return to display the Change P/O History 
window. 

• The quantity field will be displayed as a negative quantity.  Make any necessary changes and 
click Done.   

• To print the purchase history, open the Print menu to display the Print Purchase Order 
History window.  

 
Price History 
You can track the price history of your items.  When the price of an item has been changed, the Date, 
Time, User that made the change, the Action of the change, and the Old and New price will be 
recorded.  The Action of the price change refers to whether the price was changed manually, changed 
using purchase orders, or changed using the mark up feature. 

• With the correct item selected from the Inventory list, right-click and from the shortcut menu 
click Price History to display the Item Price History window. 

• To print the report, open the Print menu and click Report. 
• To preview the report onscreen, select Preview and on the Print menu click Report. 

 
Set up an item reminder 
AVImark allows you to set up a reminder template for any item.  For a detailed discussion on setting 
up Reminder Templates, refer to “CHAPTER 11: REMINDERS”. 

• With the correct item selected right-click and from the shortcut menu click Reminder. 
• You will need to click Yes to create one and display the Reminder Template. 
• Specify the various conditions for the reminder and click Done. 

 
Undelete a deleted item 
AVImark gives you the ability to undelete any item that may have been deleted. 

• In the Inventory List window, right-click and from the shortcut menu click Undelete to 
display the Undelete Inventory Items window. 

• If applicable, select the Undelete to a Lost and Found category to place the revived items in 
a category named L & F with the date and time they were revived. 

• Click on the item you wish to undelete.  Use the SPACEBAR or right-click and from the 
shortcut menu click Select.  The item will appear bolded when selected. 

• After all items have been selected, click Undelete. 
 
Variance 
The Variance option gives you the ability to report controlled substances that are unused for whatever 
reason appropriate (i.e. spilled, lost, unfit, etc.). Variances are recorded when you enter items into the 
Medical History of the patient, thus, making the entry specific for that patient.  Any changes made to 
the items on-hand quantity, whether it is increased, decreased, removed, etc., will also be recorded in 
the Variance Entries window. You may also enter variances through the Variance Maintenance 
window. Variance entries will print on the Controlled Substance Report.  To input a variance on an 
item, you must set up entries in the Variance Table of the AVImark System Tables. For detailed 
information on setting up your Variance Table, refer to “CHAPTER 2: SYSTEM TABLES”.   

• With the correct item selected, right-click and from the shortcut menu click Variance to 
display the Variance Entries window. 
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• Right-click and from the shortcut menu click New to display the New Variance Entry 

window.    

 
• The Code for the selected item will already be displayed.  TAB to have the Description field 

entered for you. 
• Use the Change field UP and DOWN ARROWS to enter the appropriate amount. 
• TAB to the Reason field and use the drop-down list to select the appropriate reason. 
• Use the Doctor drop-down list and select the name of the user who is making the entry. 

• If appropriate, use the Patient field browse button  to select a specific patient for the 
variance. 

• The Date and Time fields will be entered automatically but may be changed if applicable.  
• If necessary, enter any Notes that may be applicable for this entry and click OK to save. 

  
When tracking partial quantities of a given substance that is deemed unusable, you will 
want to “dispense” those quantities into the Medical History area of a “waste” patient 
record.  In other words, create a new client record named “Controlled Substances Waste”, 
and add “patient” records, each with a name that signifies the month and year of the waste 
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To learn more about: Search the Help for:  
 Track controlled substance Controlled substance; Tracked controlled substances 

 
View and print the Whogot list 

The AVImark Whogot list is a sorted list of all patients and their owners that have received a specified 
treatment, inventory item, problem, or diagnosis.  Use the Whogot list to view, sort, print, or go to the 
CID of any patient receiving the chosen treatment, item or diagnosis in a specified number of months. 

• With the appropriate item selected, right-click and from the shortcut menu click Whogot to 
display the Treated Patients window. 

 
• If applicable, use the Criteria menu to sort and/or limit the number of patients selected. 
• Click Done to return to the Treated Patients window. 
• Select the individual patients from the list you wish to print by clicking on the patient name 

and press the SPACEBAR. 
• Click Print to display the Print Whogot window. 

disposal.  For example:  September-09, October-09, November-09, and so on.  You would 
also need to set this “client” up as having 100% discounting applied so as not to report 
inaccurate income, production, or A/R numbers.  Then, during a given month, you would 
dispose of the controlled substance waste by entering the waste quantities into the Medical 
History area of the appropriate patient, posting the entry, canceling the payment window 
and closing the invoice. 
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• Use the Print to drop-down list and select the correct Printer. 
• Using the Months to show field, enter the number of months to display or use the drop-down 

calendar to specify the period you wish to print for. 
• If applicable, double-click in the Document field to select a Document from among your MS 

Word documents. 
• Select Include notes to include the notes about the item selected for each patient on the list. 
• To omit the prescription messages, check the Exclude scripts checkbox. 
• If applicable, click on Restrict to last query to limit the printing of documents to only those 

patients chosen when you ran the last information search. 
• Click Print or to preview the report onscreen select Preview and click Print. 

 
View and Print Inventory Reports and Documents 

From the File menu of the Inventory List window, you may view and/or print a variety of reports and 
documents. 
 
Inventory Report 
The Inventory Report should be printed out at the beginning of each year.  If not, AVImark will 
display a warning informing the user that the report has not yet been printed. The warning will persist 
until the report is physically printed. A specific start-of-year date can be specified in Hospital Setup, 
Advanced. 

• On the File menu, point to Print and click Inventory Report to display the Inventory Report 
window. 

• Using the Organize by area, select how you wish to organize the report. 
• Select a Sort by option. 
• If appropriate, select how the report will be restricted. 
• If appropriate, select any Options that may be necessary and click Print.  To preview the 

report onscreen, select Preview and select Print. 
 
Travel Sheet 
The Travel Sheet is a customized list of commonly used items that you use during the visit with the 
patient.  By default, only those items with the “F” Action code will be included on the Travel Sheet. 

• On the File menu, point to Print and click Travel sheet to display the Print Travel sheet 
window. 
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Vendor List 
This report allows you to view and print a list of your vendors. 
 
Purchase Order History 
Once inventory has been purchased and receipted into stock, AVImark will track past purchase orders. 
 
Inventory Summary 
AVImark will print a sales summary report showing monthly and yearly production values along with 
last years production and growth percentage.  Profit values are also given. 
 
Reorder Report 
This report allows you to print a list of all Inventory items that have On-hand quantities equal to or 
below the Order Point.   

 
Update Inventory Sales 

The Update Sales option in Inventory gives you the capability to update monthly Inventory totals.  
These monthly totals are automatically generated at the beginning of each month for the previous 
month, when the message regarding “Updating Inventory Statistics” is prompted and allowed to 
process.  If these statistics are not allowed to process at the beginning of the month, but for example, at 
the middle of the month, all sales for the previous month and the current month will be lumped 
together.  Should this happen, running the Update Sales feature will reorganize these statistics to their 
appropriate month. 

• From your Inventory List, open the File menu and click Update Sales to display the Update 
Inventory Sales window. 

 
• Click Update. You will need to click Yes to confirm. 
• Click OK when updating is complete. 

 
Add Vendors 

Before associating a vendor to a specific item or before creating orders you must first set up the list of 
vendors. 

• From the Inventory List select File (menu), Vendors. 
• Select right-click New to add a vendor. 
• Enter a Code and vendor Name. 
• In the Contact field enter the main contact person. 
• Enter your Account number and the vendor address information. 
• Click in the appropriate fields to enter the desired information. 
• In the Comments field enter desired notes or additional information about the vendor. This 

information will be included on the Vendor report.  
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Create Purchase Orders 

AVImark has an extensive ordering capability feature designed to handle your normal ordering needs.  
You may manually select the items that you wish or AVImark can automatically place items reaching 
their “Order Point” on the order.  The process consist of three steps; building the order, printing and/or 
releasing the order, and receipting the order once received. 
 

Order an individual item  

• From your Inventory List, select the item that you wish to order.  
• On the File menu point to Order and click New to display the Build Purchase Order window.   

 
• AVImark automatically assigns a Purchase Order number of “yymmdd” plus a two digit 

number representing the number of purchase orders you have created today.  However, you 
may assign your own preferred numbering sequence consisting of 8 characters or less.   

• By default, AVImark will set the new order to This item only then click continue. 

 
 
Order multiple items 

• From your Inventory List, select the items you wish to order by clicking on the item and using 
the SPACEBAR to place the item in the Selected Item area. 

• On the File menu, point to Order and click New to display the Build Purchase Order 
window.    
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• AVImark automatically assigns a Purchase Order number of “yymmdd” plus a two digit 
number representing the number of purchase orders you have created today.  However, you 
may assign your own preferred numbering sequence consisting of 8 characters or less. 

• By default, AVImark will set the new order to Selected items. 
• Click Continue to display the Purchase Order. 

 
Order items that have reached their Order Point 

• On the File menu, point to Order and click New to display the Build Purchase Order window. 
• Select the Consider…option that you wish. 
• Click Continue to display the Purchase Order. 

 
Print and/or Release the order 
AVImark gives you the ability to simply print an order, allowing you to make further changes if 
necessary, or release a completed order.  When you release a purchase order, you are telling AVImark 
that no further changes are necessary and that the order is ready to be released to the vendor.  Once the 
order has been released, no further changes can be made. 

• To make a change to an item on the order, select the item and right-click to display the 
shortcut menu.  

• Click Change to display the Change P/O Item window.      
• Make the necessary changes and click Done. 
• To print the order, open the Order menu and click Print. 
• To preview the order onscreen, select Preview and from the Order menu, click Print. 
• To release the order, open the Order menu and click Release.  This will print the order and 

change the order status to an “Open Order”. 
 

Receipting an order 
As orders are filled from each of the various vendors and shipped, you will want to receipt the orders 
into stock.  AVImark lets you receipt the order and specify which items were received.  Of the received 
items you are able to indicate which ones reflect a change in price, specify what vendor the items were 
received from, and apply any shipping charges and taxes that have been charged to you.  In addition, 
AVImark will create a “back order” for those items that were not received and you can receipt them if 
and when they do come in.  If the items never show up, you may just purge the order. 

• From your Inventory List open the Order menu and click Choose to display the Choose 
Order window. 

 
• Select the correct order from the list and click Done to display that Purchase Order. 

 
Receipt a partial order: 

• To receipt a partial order, select the top order from the list that has been received. 
• To make a change to the item, (cost, amount received, and so on) right-click and from the 

shortcut   menu click Change to display the Change P/O Item window. 
• Make the necessary change(s) and click Done to return to the Purchase Order. 
• Right-click and from the shortcut menu click Receive.  The received value for the item will be 

set to the number ordered, divided by its Order Pack value. 
• Repeat the same procedure for each item that has been received. 
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• On the Purchase Order window, open the Order menu and click Receive to display the 
Purchase Order Receipting window.  It is from this window where you will enter the Vendor, 
Invoice  number, any shipping charges, taxes, and/or other cost associated with the item. 

• Click Continue to finish receipting the item(s) and to place the status of the order to “Back 
Order”. 

 
Receipt a complete order: 

• Select the correct order from the list and click Done to display the Purchase Order. 
• On the Order menu, click Receive.         
• You will receive a prompt that the quantity for each item has been set to the quantity ordered.   

Click Yes. 
• To make a change to any of the items, (cost, amount received, and so on) right-click and from 

the shortcut menu click Change to display the Change P/O Item window. 
• Make the necessary change(s) and click Done to return to the Purchase Order. 
• On the Order menu, click Receive to display the Purchase Order Receipting window.    
• Enter the Vendor, Invoice number, any shipping charges, taxes, and/or other cost associated 

with the order and click Continue.  AVImark will automatically update the on-hand 
quantities, honor any price mark up percentages specified, and so on. 

 
Purge Orders 

AVImark gives you the ability to purge orders that are outdated or otherwise no longer appropriate. 

• On the order in question, open the Order menu and click Purge. Click Yes to confirm. 
  

To learn more about: Search the Help for:  
 Purchase orders Purchase order 

 
 

Setup Associated Veterinary Purchasing for Canadian Clinics 
AVImark integrates with Associated Veterinary Purchasing (AVP) which will allow Canadian 
AVImark clinics that are AVP customers the ability to place an order through AVImark.  
 
Setup 
To use the AVP integration specifications must be defined in Hospital Setup Advanced area.  

• From the CID open the Advanced Options by clicking on the Hammer, Wrench and 
Screwdriver icon.  

• In the Search field type AVP. 
• The AVP Billing Code is assigned by AVP and will be unique to each clinic.  
• The AVP FTP Address automatically defaults to the AVP FTP address.  
• Click the Directory option to enter the name of the new AVP folder that you have created in 

the AVImark folder.  
• The FTP Password and FTP User Name will both be automatically setup.  
• AVP will provide a password and user name to be entered in the Password and User Name 

fields.  
 
Adding AVP Vendor 
After defining the AVP specifications the AVP vendor needs to be added to the Vendor list.  

• From the Inventory List choose File, Vendors from the menu. 
• The Code and Name of the vendor must be AVP. 
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Attaching AVP Number 
After defining the options in Hospital Setup a new field will be available in the Change Item window. 

• In the Inventory List select the correct item and choose Change from the right-click menu. 
• From the Advanced tab enter the billing code of the item in the AVP Number field.   

 
Placing an Order 
When placing an order for AVP you will need to select AVP as the vendor or assign the AVP vendor 
to all appropriate items.  

• When the AVP vendor is selected a Ship To field will be displayed in the Purchase Order 
window.  

• The Ship To field will default to the clinics location; however clicking on this drop-down list 
will display all possible locations, which are downloaded from the AVP webserver. 

 
Releasing an Order 
As each purchase order is released the product code(s) will be verified and the inventory status will be 
checked for sufficient and/or insufficient quantities. If the item is not in stock you will receive a 
message showing the current available quantity giving you the option to change the quantity on the 
order, remove the item or select a substitute.  
Once the order is released AVImark exports the purchase data to a file that is uploaded via FTP to 
AVP. If the file is sent successfully an e-mail notification will be sent to orders@avpbc.com with the 
filename as the subject. The order will then be processed and the order can be received as normal.   
 

Work With VPR Formulary 
With the VPR Formulary you can access drug formulary information and provide drug information 
sheets to your clients along with their pets prescriptions.  
 
Setup  

• After installing the VPR software specify the path in Advanced Options. From the CID select 
the Hammer, Wrench and Screwdriver speed bar button. In the Search field type VPR, 
select the VPR Folder option and click Change to specify the location of the VPR software. 

• In the Search field type active and under Veterinary Pharmacy Reference select Active and 
set the value to True.    

• To register the appropriate dll files open the CID, hold down the Shift + Ctrl keys, select 
Utilities, Register from the menu and click VPRClassCodeGen.dll. 

 
Additional VPR settings can also be defined in the Hospital Advanced Options. Listed are just a couple 
of the options.  

• In the Search field type vpr and select the option Print VPR Drug Info Sheets when 
printing Drug Labels. Setting this option to True will print the sheets along with the drug 
label for an item that has a VPR code assigned.  

• In the Search field type interaction. Select Check History for Drug Interactions to have 
AVImark search for VPR associated codes in Medical History; choose Check History for 
Drug Interactions at Entry? to initiate the drug interaction when adding a VPR treatment or 
item in Medical History; and choose Check History for Drug Interactions Days Back to 
specify the number of days the Interactions Matrix will search Medical History for drug 
interactions.  

 
Accessing VPR 
The VPR Formulary can be easily accessed from different areas within AVImark. 

• From the CID select the Utilities menu and click Formulary. 
• In the Patient area of the CID from the right-click shortcut menu select Formulary. 
• In the Medical History area of the CID from the right-click shortcut menu select 

Formulary. 
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• From the Medical History Inventory Used window right-click and from the menu select 
Formulary.  

• By opening the Drug Label window in Medical History access the formulary by selecting the 
Formulary menu option.  

• Open the Inventory List, select an item and from the right-click menu select Formulary to 
access the VPR Formulary.  

• In the Inventory List select an item, open the Change Item window and click the 
Formulary menu option to access the VPR.  

• In the Treatment List select a treatment and from the right-click menu click Formulary.  
• In the Treatment List select a treatment and open the Change Treatment window. Click the 

Associated Treatments/Items option and under the Inventory Used tab highlight an entry 
and from the right-click menu select Formulary to access the VPR. 

 

 
 
Assigning VPR Drug Codes to Items 
When assigning a VPR code to an item this will allow drug formulary information to be automatically 
displayed when the VPR Formulary is opened from that item.  

• In the Inventory List select the appropriate item and from the right-click menu select Change.  
• Click the Advanced tab and from the Link to VPR drop-down list select the drug you wish 

to associate with this item. Click OK once the appropriate drug has been associated.  
 
Using the Formulary 

• From Medical History select an item and choose Formulary from the right-click menu. If this 
item does not have an associated VPR code you can select a code from the Dosage 
Calculator tab. AVImark will display a message allowing you to place this VPR code in the 
VPR field of the Change Item window for this item.  
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• From Medical History select an item that has a VPR associated code and choose Formulary 
from the right-click menu. This will display that drug information but another VPR code can 
be chosen from the Select Drug drop-down list.  

 
 
 

To learn more about: Search the Help for:  
 VPR Formulary VPR Formulary 
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